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1. Introdução 

O Manual de Utilização para a Indústria (MUI) é o manual de referência que descreve aos 
utilizadores da indústria a forma como podem enviar e visualizar dados no REACH-IT. A 
evolução do REACH-IT será acompanhada da publicação de partes novas e atualizadas do 
presente MUI, as quais serão disponibilizadas no sítio Web da ECHA. 

Antes da utilização desta Parte 7 (Apresentação Conjunta), recomenda-se a leitura da Parte 1 
– Introdução ao REACH-IT, onde são abordados detalhadamente os tópicos seguintes: 

• Estrutura do MUI 

• Convenções utilizadas para ícones, texto, botões, ligações, etc. 

• Informações gerais sobre o REACH-IT e a sua ligação ao sítio Web e à aplicação da 
IUCLID 5 

A Parte 1 descreve igualmente a forma de obter assistência adicional. Desse modo, cada parte 
subsequente do presente MUI conterá instruções passo a passo para a execução das tarefas 
necessárias para o envio de dados ao abrigo do REACH. 

 

2. Conceito geral de Apresentação Conjunta 

2.1 Ligação para o Regulamento REACH 

Os Fabricantes, Importadores ou Representantes Únicos estão individualmente obrigados a 
apresentar um registo para cada substância pela qual são responsáveis. Nos casos em que a 
substância é fabricada ou importada por mais do que uma empresa, os potenciais registantes 
devem apresentar conjuntamente determinadas informações. Este processo tem a designação 
de Apresentação Conjunta de dados.  

A Apresentação Conjunta pode aplicar-se a uma substância a registar [artigo 11.º do 
Regulamento REACH], incluindo substâncias intermédias isoladas nas instalações ou 
transportadas [artigo 19.º do Regulamento REACH], e ainda a uma substância para a qual seja 
obrigatória uma notificação de classificação e rotulagem.  

Os registantes devem apresentar conjuntamente informações relativas às propriedades 
perigosas da substância, à sua classificação e rotulagem e proposta(s) de ensaio (se aplicável). 
É ainda possível apresentar conjuntamente o relatório de segurança química e orientações 
para uma utilização segura (artigo 11.º do Regulamento REACH) se for celebrado um acordo 
entre os participantes da Apresentação Conjunta. 

2.2 Funções do registante principal e dos registantes membros 

Cada Apresentação Conjunta terá um Registante Principal (a seguir designado por Registante 
Principal). A empresa com a função de Registante Principal terá as seguintes 
responsabilidades: 

• Criação da Apresentação Conjunta no REACH-IT 

• Apresentação do dossiê do Registante Principal 

• Gestão da Apresentação Conjunta (por exemplo, gestão do código de segurança). 

As outras empresas que participam na Apresentação Conjunta são conhecidas como 
registantes Membros (a seguir designadas como Membros). Os Membros terão as seguintes 
responsabilidades: 
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• Confirmação da sua participação na Apresentação Conjunta no REACH-IT 

• Apresentação dos seus dossiês de Membros. 

As noções básicas do procedimento são explicadas nos capítulos 2.3 e 2.4 e o capítulo 3 
contém instruções passo a passo. 

2.3 A Apresentação Conjunta 

O presente capítulo descreve os principais elementos de uma Apresentação Conjunta no 
REACH-IT. 

2.3.1 Identificação da substância 
Cada Apresentação Conjunta incide sobre uma substância específica. Esta substância é 
definida pelo Registante Principal durante a criação da Apresentação Conjunta. O Registante 
Principal pode definir a identidade da substância para a Apresentação Conjunta com base 
numa das seguintes opções: 

• Uma das substâncias pré-registadas da empresa (número de pré-registo). 

• Uma das substâncias consultadas da empresa (número de consulta).  

• Uma das substâncias da empresa já registadas, incluindo as substâncias NONS 
(substâncias notificadas nos termos da diretiva 67/548/CEE) (número de registo) para 
as quais foi solicitado o número de registo. 

Se não for aplicável nenhuma destas opções, o utilizador pode definir a substância através do 
método utilizado para o pré-registo. 

 Neste caso, no entanto, o utilizador deve fornecer uma explicação para o facto de 
não indicar uma substância pré-registada/consultada ou uma já registada. 

2.3.2 O código de segurança  
Um código de segurança é uma cadeia de caracteres alfanuméricos criada automaticamente para a 
Apresentação Conjunta durante o processo de criação e disponibilizada ao Registante Principal que 
cria a Apresentação Conjunta. O objetivo deste código de segurança é o de assegurar a associação 
definitiva entre o Registante Principal e os Membros na Apresentação Conjunta. Em conjunto, o 
nome da Apresentação Conjunta e o código de segurança podem ser considerados como uma 
identificação de utilizador e palavra-passe utilizados especificamente para confirmar a participação 
na Apresentação Conjunta. 

O código de segurança é partilhado entre o Registante Principal e todos os Membros potenciais 
que o utilizam para confirmar a sua participação na Apresentação Conjunta (ver capítulo 3). 
Na prática, os Membros potenciais devem introduzir o nome da Apresentação Conjunta e o 
respetivo código de segurança para iniciar a confirmação da sua participação na Apresentação 
Conjunta. 

 Cada código de segurança tem uma validade limitada de trinta dias a contar da 
data de criação. Depois de expirado, apenas o Registante Principal pode criar um 
novo código de segurança para a Apresentação Conjunta no REACH-IT. 

 O Registante Principal deve informar os Membros potenciais sobre o código de 
segurança fora do REACH-IT (por exemplo através de correio eletrónico). 

 O Registante Principal pode criar um novo código de segurança em qualquer 
altura. Se o criar, o código de segurança anterior deixa de ser válido e é 
substituído pelo novo código, o que permitirá ao Registante Principal ter um maior 
controlo sobre quem está apto a participar na Apresentação Conjunta se 
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considerar que a confidencialidade do código de segurança original foi 
comprometida. 

 Se um Membro potencial introduzir um código de segurança inválido (ao tentar 
confirmar a sua participação) mais vezes do que as 5 permitidas, o REACH-IT 
impedirá novas tentativas. Neste caso, o Membro potencial e o Registante Principal 
são informados através do REACH-IT (por mensagem interna) de que foi atingido o 
número máximo de tentativas para introduzir o código de segurança. O Membro 
potencial deve contactar o Registante Principal (fora do REACH-IT) e solicitar que o 
seu contador de tentativas inválidas seja reposto a zero. Depois de o Registante 
Principal ter reposto o contador de tentativas inválidas do registante Membro 
potencial, este pode tentar novamente confirmar a sua participação utilizando o 
código de segurança válido. 

 Se um Membro potencial introduzir um nome de Apresentação Conjunta 
inválido (ao tentar confirmar a sua participação) mais vezes do que as 5 vezes 
permitidas, o REACH-IT impedirá novas tentativas. Neste caso, o Membro 
potencial deve contactar a ECHA para que o seu contador de tentativas inválidas 
seja reposto a zero antes de uma nova tentativa. 

2.3.3 Terceiro como Representante 
O Registante Principal e os Membros podem escolher ocultar a sua identidade na Apresentação 
Conjunta através da Utilização de um Terceiro como Representante. As empresas podem 
definir um Terceiro como Representante durante a criação de uma Apresentação Conjunta ou 
durante a confirmação da sua participação. Se uma empresa definir um Terceiro como 
Representante, as informações de contacto dessa empresa (que deverá mesmo assim definir) 
não serão apresentadas a outras empresas (Registante Principal ou Membro) na Apresentação 
Conjunta, sendo apresentadas em substituição as informações de contacto do Terceiro como 
Representante. Importa referir que, se um Terceiro como Representante for utilizado, durante 
a criação do dossiê IUCLID 5, deve incluir, na secção 1.1 do dossiê IUCLID, a entidade jurídica 
do Terceiro como Representante no campo apropriado («Third party» [Terceiro]). 

2.4 Apresentação do dossiê numa Apresentação Conjunta 

Os participantes de uma Apresentação Conjunta apresentarão os dossiês à ECHA através do 
REACH-IT, que possibilita a apresentação de ficheiros de dossiê preparados fora do sistema 
REACH-IT, na IUCLID 5. 

2.4.1 Cronologia das apresentações 
Em termos de cronologia, o Registante Principal apresentará primeiro o dossiê principal da 
Apresentação Conjunta. Os Membros abrangidos pela Apresentação Conjunta podem ser 
identificados (opcional) no dossiê principal (IUCLID 5, secção 1.5). 

Só depois de o dossiê principal para a Apresentação Conjunta ter sido aceite para 
processamento, ou seja, ter sido aprovado na verificação das regras de negócio, é que os 
Membros poderão apresentar os seus dossiês de Membros. A página Apresentação Conjunta no 
REACH-IT indicará aos Membros quando o dossiê principal tiver sido aprovado na verificação 
das regras de negócio e que poderão iniciar então a apresentação dos respetivos dossiês de 
Membros. 

2.4.2 Requisitos de informação do dossiê 
As informações que devem ser apresentadas conjuntamente são fornecidas apenas pelo 
Registante Principal em representação dos restantes Membros. O Registante Principal tem a 
responsabilidade de criar um dossiê da IUCLID 5 que contenha todos os requisitos do 
Regulamento REACH relacionados com a gama de tonelagem máxima no âmbito da 
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Apresentação Conjunta. Por conseguinte, deverá utilizar o modelo de dossiê da IUCLID 5 em 
conformidade. 

Cada Membro da Apresentação Conjunta deverá apresentar, separada e individualmente, as 
seguintes informações administrativas: 

• Identidade da entidade jurídica 

• Identidade da substância 

• Informações relativas ao fabrico, à utilização da substância, incluindo a tonelagem, bem 
como informações sobre a exposição. 

Os Membros deverão utilizar o modelo de dossiê «Member of a Joint Submission» [Membro de 
uma Apresentação Conjunta] na IUCLID 5 quando prepararem os seus dossiês de Membros. 

Um Fabricante ou Importador pode optar pela auto-exclusão de algumas partes do dossiê de 
registo conjunto (auto-exclusão de Apresentação Conjunta). A auto-exclusão pode basear-se, 
por exemplo, em custos desproporcionados, na possibilidade de a divulgação das informações 
causar prejuízos comerciais consideráveis ou no desacordo com o Registante Principal sobre a 
seleção das informações apresentadas no registo do Registante Principal (artigo 11.º do 
Regulamento REACH). 

2.4.3 Processamento de Apresentações Conjuntas 
Cada dossiê de Apresentação Conjunta (Registante Principal e Membro) é submetido às 
verificações de regras de negócio do REACH-IT, à Verificação Técnica de Integralidade (TCC) e 
a todos os passos associados à faturação. Para mais informações sobre estes tópicos, consulte 
os seguintes manuais de utilização: 

• Manual de Apresentação de Dados 4 – Como obter aprovação nas regras de negócio 
(«Enforce Rules» [Regras de execução])  

• Manual de Apresentação de Dados 5 – Como preencher um dossiê técnico para registos 
e notificações PPORD 

• Manual de Utilização para a Indústria, Parte 6 – Apresentação de dossiê 

 

Os manuais estão disponíveis no sítio Web da ECHA em: 

http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it 

No que respeita especificamente às Apresentações Conjuntas, aplicam-se os seguintes 
princípios de processamento: os dossiês dos Membros apenas poderão ser considerados como 
concluídos quando a ECHA tiver considerado o dossiê do respetivo Registante Principal como 
concluído. 

Se o dossiê de um Membro for submetido à Verificação Técnica de Integralidade e a faturação 
mais rapidamente do que o respetivo dossiê principal, o dossiê do Membro deverá aguardar 
que o dossiê principal seja processado com êxito. O processamento do dossiê do Membro 
apenas será concluído e será emitido um número de referência (por exemplo, um número de 
registo) ao Membro depois de ter sido atribuído um número de referência ao Registante 
Principal.  

 O motivo para não emitir um número de referência aos Membros antes de o 
Registante Principal da Apresentação Conjunta ter concluído com êxito o 
processo de registo tem a ver com o facto de os Membros estarem 
dependentes das informações apresentadas pelo Registante Principal para 

http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it
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cumprir plenamente os requisitos de informação do Regulamento REACH. 

 

3. Instruções passo a passo 

O primeiro passo é a criação da apresentação conjunta no REACH-IT. O processo é descrito no 
capítulo 3.1. 

 A Apresentação Conjunta deve ser criada apenas pelo Registante Principal.  

No final do processo, a Apresentação Conjunta é criada e armazenada no REACH-IT. No final 
do processo de criação da Apresentação Conjunta, o código de segurança da Apresentação 
Conjunta é disponibilizado ao Registante Principal através de uma mensagem interna no 
REACH-IT. O Registante Principal deve comunicar o código de segurança aos Membros 
potenciais para que estes possam confirmar a sua participação na Apresentação Conjunta. A 
confirmação da participação numa Apresentação Conjunta é descrita no capítulo 3.2. 

 Os Membros potenciais necessitam do nome da Apresentação Conjunta e do 
código de segurança para poderem confirmar a sua participação. 

Uma vez criada a Apresentação Conjunta no REACH-IT, o Registante Principal pode apresentar 
o dossiê de Registante Principal relativo a essa Apresentação Conjunta. 

Depois de os Membros terem confirmado a sua participação na Apresentação Conjunta e de o 
Registante Principal ter apresentado o dossiê principal, os Membros podem apresentar os seus 
dossiês de Membro relativos a essa Apresentação Conjunta. 

 O capítulo 3.1 do presente manual aborda a criação da Apresentação Conjunta e 
aplica-se apenas ao Registante Principal. 

O capítulo 3.2 e seguintes destinam-se ao Registante Principal e aos Membros da 
Apresentação Conjunta. 

3.1 Criar uma Apresentação Conjunta 

A criação de uma Apresentação Conjunta é um processo que envolve cinco passos. O REACH-
IT orientará o utilizador ao longo deste processo através de um assistente. A Apresentação 
Conjunta deve ser criada apenas pelo Registante Principal.  

3.1.1 Passo 1 – Identificar a substância 
Na página inicial, clique em <Joint submission> [Apresentação conjunta] e, em seguida, em 
<Create joint submission> [Criar apresentação conjunta] (Figura 1). 
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Figura 1: Página Criar Apresentação Conjunta (a partir do menu) 

 

É apresentada a página <Create joint submission substance> [Criar substância da 
apresentação conjunta] (Figura 2). Primeiro, deve selecionar a substância adequada. 

Figura 2: Página Procurar substância (para a Apresentação Conjunta) 

 

Para selecionar a substância da Apresentação Conjunta, selecione um <Reference number 
type> [Tipo de número de referência] (pré-registo, número de consulta ou de registo) e 
indique um <Reference number> [Número de referência] ou utilize a opção <specifying the 
substance identity> [especificar a identidade da substância). As duas opções, «Search via 
reference number type» [Pesquisar através do tipo do número de referência] e «Search via 
specification of the substance identity» [Pesquisar através da especificação da identidade da 
substância], serão abordadas a seguir. 

Pesquisar através do tipo de número de referência 

É possível indicar um <Pre-registration number> [Número de pré-registo], <Inquiry number> 
[Número de consulta] ou <Registration number> [Número de registo] para identificar a 
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substância da Apresentação Conjunta. Para realizar a pesquisa, assinale a informação 
obrigatória (*) <Reference number type> [Tipo de número de referência] (clique no botão de 
rádio correspondente) (Figura 2) e introduza o número no campo de entrada obrigatório (*) 
<Reference number> [Número de referência]. Clique em <Search> [Pesquisar] (Figura 2) 
para visualizar a página de resultados (Figura 3). 

Figura 3: Resultado da pesquisa de substâncias através do número de referência 

 

Avance para o passo seguinte, conforme descrito no capítulo 3.1.2 (Passo 2 – Introduzir as 
informações relativas à Apresentação Conjunta). 

Pesquisar através da especificação da identidade da substância 

 Se a substância não tiver sido pré-registada, consultada ou não tiver um número 
de registo, a pesquisa é efetuada através de <specifying the substance identity> 
[especificação da identidade da substância] (Figura 2). 

Pode, depois, selecionar manualmente a identidade da sua substância. Clique na ligação 
<Specifying the substance identity> [Especificação da identidade da substância] (Figura 2) 
para visualizar a página do assistente de identificação da substância (Figura 4). 

Figura 4: Página Assistente de identificação da substância 

 

Clique em <Add another constituent> [Adicionar outro componente] (Figura 4), para 
identificar o(s) componente(s) da sua substância (Figura 5). Depois de introduzir o texto da 
justificação obrigatória no campo <Explanation> [Justificação], pode utilizar a opção 
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<Search> [Pesquisar] para pesquisar um componente. Pode especificar o componente através 
do <EC number> [número CE], <EC name> [nome CE], <CAS number> [número CAS] ou 
<Molecular formula> [Fórmula molecular], e também utilizar o carácter universal de pesquisa 
asterisco (*) no campo de entrada.  

No ecrã seguinte, foi utilizado <silver> [prata] como exemplo no campo de entrada <EC 
name> [nome CE] e, em seguida, clicou-se no botão <Search> [Pesquisar]. O resultado da 
pesquisa é apresentado na parte inferior da página (Figura 5) e diz respeito a <silver> [prata]. 

Figura 5: Página Pesquisar Substância CE (para adicionar componentes) 

 

 Se decidir pesquisar manualmente a sua substância, deve justificar claramente o 
motivo pelo qual não utiliza o número de referência (número de pré-registo, de 
consulta ou de registo). 

Ao pesquisar através de um carácter universal, por exemplo, «200*», os resultados podem 
exceder 500 substâncias químicas e, nesse caso, deverá restringir a pesquisa, utilizando 
fragmentos mais detalhados seguidos/precedidos por um carácter universal de pesquisa (*), 
por exemplo, <200-0*>. Depois de identificar o componente pretendido, utilize o botão de 
rádio para o selecionar. Clique em <Select constituent> [Selecionar componente] (Figura 5) 
para adicionar um novo componente à sua substância. Em seguida, o REACH-IT apresenta 
uma página com o componente que selecionou (Figura 6). 

Figura 6: Adicionar um componente à substância 
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Clique em <Continue> [Continuar] (Figura 6) para confirmar o componente selecionado. Para 
alterar a sua seleção, clique em <Modify> [Modificar]. Os componentes adicionais podem ser 
adicionados um a um. Na página de identificação da substância (Figura 7), são apresentados 
os componentes adicionados. 

Figura 7: Confirmação da adição de um componente à substância 

 

Nesta fase, ainda pode adicionar ou remover um componente. O botão <Add another 
constituent> [Adicionar outro componente] ativa os passos descritos anteriormente e o botão 
<Remove a constituent> [Remover um componente] permite remover um componente 
selecionado anteriormente. Clique em <Next> [Seguinte] para visualizar o separador <Joint 
Submission> [Apresentação Conjunta] (Figura 8).  

3.1.2 Passo 2 – Introduzir as informações relativas à Apresentação Conjunta 
Na qualidade de Registante Principal, deve introduzir o nome da Apresentação Conjunta e uma 
descrição da mesma (opcional) (Figura 8).  

 O nome da Apresentação Conjunta deve ter entre 8 e 30 caracteres. 

Figura 8: Página Informações da Apresentação Conjunta 

 

Para terminar o processo, clique em <Cancel> [Cancelar]; será solicitada a sua confirmação. O 
botão <Cancel> [Cancelar] fá-lo-á regressar à criação da sua Apresentação Conjunta. 

Para concluir a criação da Apresentação Conjunta, clique em <OK>. 

Se clicar em <Next> [Seguinte], é apresentada a página <Contact> [Contacto] (Figura 9). 
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3.1.3 Passo 3 – Selecionar a pessoa de contacto adequada 
A pessoa de contacto responsável pelo acompanhamento da Apresentação Conjunta pode ser 
selecionada na lista de contactos (Figura 9) já disponibilizada no REACH-IT pela empresa do 
Registante Principal durante a inscrição da empresa.  

Além disso, é possível definir uma nova pessoa de contacto (Figura 9). Clique em <Create a 
new contact information> [Criar a informação de um novo contacto] para criar uma nova 
pessoa de contacto (os detalhes estão disponíveis no Manual de utilização para a Indústria, 
Parte 2 – Inscrição e gestão de conta).  

 O(s) contacto(s) criado(s) através da opção <create a new contact information> 
[criar informação de um novo contacto] terá(ão) atribuída automaticamente a 
função de «Joint Submission» [Apresentação Conjunta] em <Contact Type(s)> 
[Tipo(s) de Contacto]. 

Figura 9: Página Contactos da Apresentação Conjunta 

 

Clique em <Next> [Seguinte] para avançar para o separador <Representative> 
[Representante]. 

3.1.4 Passo 4 – Selecionar um Terceiro como Representante (opcional) 

 Selecionar ocultar a sua identidade através da utilização de um Terceiro como 
Representante é opcional. 

Pode escolher eleger um Terceiro como Representante no separador <Representative> 
[Representante] ou continuar para a página <Validation> [Validação] premindo <next> 
[seguinte] (Figura 10).  

Se tiver um Terceiro como Representante para a sua substância, clique na ligação <new third 
party representative> [novo terceiro como representante] e introduza o número UUID 
fornecido pelo seu Terceiro como Representante que se inscreveu previamente no REACH-IT. 
Importa referir que, se um Terceiro como Representante for utilizado, durante a criação do 
dossiê IUCLID 5, deve incluir, na secção 1.1 do dossiê IUCLID, a entidade jurídica do Terceiro 
como Representante no campo apropriado («Third party» [Terceiro]). 



16 REACH-IT – Manual de Utilização para a Indústria Versão: 2.0  

 

Annankatu 18, P.O. Box 400, FI-00121 Helsinki, Finland | Tel. +358 9 686180 | Fax +358 9 68618210 | echa.europa.eu 

Figura 10: Terceiro como Representante  

 

3.1.5 Passo 5 – Validar criação 
Na qualidade de Registante Principal, pode verificar todas as informações introduzidas 
anteriormente no REACH-IT, para efeitos da criação da Apresentação Conjunta. Se necessário, 
pode voltar aos separadores anteriores (identificação da substância, Apresentação Conjunta e 
pessoa de contacto) para editar/alterar as informações introduzidas em cada um dos passos 
anteriores. Clique nas ligações <Go to the Substance identity section> [Ir para a secção 
Identidade da substância], <Go to the submission tab> [Ir para o separador da apresentação] 
ou <Go to the Contact person section> [Ir para a secção Pessoa de contacto] consoante 
necessário (Figura 11). 
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Figura 11: Página de validação  

 

Depois de concluir o processo, clique na opção <Create Joint Submission> [Criar Apresentação 
Conjunta] realçada a vermelho (Figura 11). Para interromper o processo, clique em <Cancel> 
[Cancelar]; será solicitada a sua confirmação para a conclusão da Apresentação Conjunta. Se 
confirmar através do botão <OK>, a criação da Apresentação Conjunta é concluída. Quando a 
Apresentação Conjunta estiver validada e criada, é apresentada uma mensagem de informação 
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(Figura 12) para confirmar que a Apresentação Conjunta foi apresentada com êxito. 

Figura 12: Página Apresentação Conjunta apresentada com êxito 

 

Quando é criada uma nova Apresentação Conjunta, é gerado um código de segurança. 

 Na qualidade de Registante Principal, tem a incumbência de comunicar o código a 
todos os outros Membros da Apresentação Conjunta. 

 Deve ainda indicar, juntamente com o código, a respetiva validade aos Membros 
da Apresentação Conjunta. 

 A partilha do código de segurança entre os Membros não é efetuada no REACH-IT, 
mas sim através de outros meios fora do REACH-IT. 

Se clicar em <OK>, o processo é concluído e é enviado para a página <Joint Submission 
Details> [Detalhes da Apresentação Conjunta], que apresenta os detalhes da nova 
Apresentação Conjunta criada. Os botões na parte inferior desta página e a gestão de uma 
Apresentação Conjunta são abordados no capítulo 3.3 (Ver Apresentação Conjunta). 

3.2 Confirmar a participação na Apresentação Conjunta  

Na qualidade de potencial Membro da Apresentação Conjunta, deve confirmar a sua 
participação através da aplicação REACH-IT, de modo a tornar-se um Membro.  

 Como pré-requisito, na qualidade de Membro, deve ter recebido do Registante 
Principal o nome exato da Apresentação Conjunta e o código de segurança.  

Para confirmar a sua participação, clique em <Joint submission> [Apresentação conjunta] (no 
menu do REACH-IT) e, em seguida, em <Confirm membership> [Confirmar participação] 
(Figura 13). 
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Figura 13: Página Confirmar participação (a partir do menu) 

 

3.2.1 Passo 1 – Introduzir nome da Apresentação Conjunta e código de 
segurança 
É apresentada a página (separador) <Token> [Código] (Figura 14). Na qualidade de Membro, 
deve inserir o nome exato da Apresentação Conjunta e o código de segurança nos campos de 
entrada obrigatórios adequados (*). 

Figura 14: Página Código de Segurança 

 

 NÃO pode prosseguir se existir uma inconsistência entre o nome da Apresentação 
Conjunta e o código. 

Em caso de inconsistência, poderá tentar novamente introduzir o nome e/ou o código corretos 
(o número máximo de tentativas é cinco) ou poderá contactar o Registante Principal para que 
este lhe forneça um código de segurança novo ou atualizado. 

Clique em <Next> para avançar para a página seguinte <Contacts> (Figura 15). Se clicar em 
<Back to home> [Voltar ao início], é enviado de novo para a página inicial do REACH-IT. 
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3.2.2 Passo 2 – Indicar contacto 
Na página <Contacts> [Contactos] (Figura 15), pode selecionar a pessoa de contacto 
responsável pela Apresentação Conjunta na lista de contactos apresentada (introduzida 
durante o procedimento de registo no REACH-IT) ou criar um novo contacto. Depois de clicar 
num contacto, através do botão de rádio, clique em <Next> [Seguinte] para confirmar que 
este contacto será utilizado nesta Apresentação Conjunta. Se pretender definir uma nova 
pessoa de contacto, clique em <create a new contact information> [criar informação de um 
novo contacto]. 

Figura 15: Separador Selecionar Contactos  

 

Quando clica em <create a new contact information> [criar informação de um novo contacto], 
é apresentada uma página adicional que lhe permite adicionar todas as informações relevantes 
do contacto (Figura 16). Deve preencher todos os campos de entrada obrigatórios marcados 
com um asterisco (*) Tenha em atenção que, em <Contact Type> [Tipo de Contacto], o 
campo <Joint Submission> [Apresentação Conjunta] é selecionado por predefinição, conforme 
mostrado em pormenor na Figura 17. Depois de preencher todos os campos adequados, clique 
em <Add> [Adicionar] para criar o novo contacto.  

Figura 16: Página Adicionar/Editar Contacto   

 

Tenha em atenção que a utilização do botão <Cancel> [Cancelar] terminará a criação de um 
novo contacto. Estão disponíveis mais informações relativas aos tipos de contacto no «Manual 
de utilização para a Indústria, Parte 2 – Inscrição e gestão de conta» disponível no sítio Web 
da ECHA. 
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Figura 17: Página Contactos – tipo de pessoa de contacto 

 

Selecione, agora, o novo contacto criado para a Apresentação Conjunta e clique em <Next> 
[Seguinte] para avançar para o separador seguinte <Representative> [Representante]. 

3.2.3 Passo 3 – Selecionar um Terceiro como Representante (opcional) 

 Selecionar ocultar a sua identidade através da utilização de um Terceiro como 
Representante é opcional. 

Pode escolher eleger um Terceiro como Representante no separador <Representative> 
[Representante] ou continuar para a página <Validation> [Validação] premindo <next> 
[seguinte] (Figura 18).  

Se tiver um Terceiro como Representante para a sua substância, clique na ligação <new third 
party representative> [novo terceiro como representante] e introduza o número UUID 
fornecido pelo seu Terceiro como Representante que se inscreveu previamente no REACH-IT. 

Figura 18: Terceiro como Representante 

 

3.2.4 Passo 4 – Validar a confirmação da participação 
A página de validação cria uma apresentação geral onde pode validar cada uma das partes das 
informações específicas introduzidas anteriormente, como, por exemplo, as informações 
relativas a <Substance identification> [Identificação da substância], <Joint Submission> 
[Apresentação Conjunta] ou <new third party representative> [novo terceiro como 
representante] (Figura 19). 
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Figura 19: Separador Validação 

 

Depois de analisar cuidadosamente as informações apresentadas, clique em <Confirm 
membership> [Confirmar participação] para confirmar a sua participação na Apresentação 
Conjunta. É apresentada uma mensagem de confirmação (Figura 20). Se clicar em <Cancel> 
[Cancelar], o REACH-IT cancelará a confirmação e regressará à página inicial. 

Figura 20: Página Conclusão 

 

Se clicar em <OK>, o processo é concluído e é enviado para a página <Joint Submission 
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Details> [Detalhes da Apresentação Conjunta], que apresenta os detalhes da sua 
Apresentação Conjunta. Os botões na parte inferior desta página e a gestão de uma 
Apresentação Conjunta são abordados no capítulo 3.3 (Ver Apresentação Conjunta). 

3.3 Ver Apresentação Conjunta 

Quer a sua empresa seja o Registante Principal ou um Membro de uma ou várias 
Apresentações Conjuntas, o REACH-IT permite-lhe consultar a lista completa da sua 
Apresentação Conjunta. Na página inicial do REACH-IT, clique em <Joint submission> 
[Apresentação conjunta] e, em seguida, em <View joint submissions> [Ver apresentações 
conjuntas] (Figura 21). 

Figura 21: Página Ver Apresentação Conjunta 

 

É disponibilizada uma opção de pesquisa (Figura 22), para pesquisar por <Joint submission 
name> [Nome da apresentação conjunta], <EC number> [Número CE], <CAS number> 
[Número CAS] ou <Chemical Name> [Nome da Substância Química]. 

Figura 22: Página Critérios de identidade da substância 

 

Introduza as informações nos campos pertinentes e clique em <Search> [Pesquisar], (A opção 
<Assign New Lead> [Nomear novo Registante Principal] é utilizada para transferir a nomeação 
de Registante Principal para um Membro da Apresentação Conjunta (estão disponíveis 
informações adicionais no capítulo 3.3.1), enquanto a opção <Manage Token> [Gerir Código] é 
utilizada para repor o contador para o Membro que excedeu o número máximo de tentativas.  
Figura 26). O REACH-IT apresentará a lista completa da sua Apresentação Conjunta já 
introduzida no REACH-IT. Estão disponíveis mais informações sobre pesquisas utilizando o 
carácter universal asterisco (*) no «Manual de Utilização da Indústria, Parte 9 – Pesquisa 
avançada», disponível no sítio Web da ECHA. 
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Figura 23: Página Ver Apresentação Conjunta 

 

Depois de selecionar uma Apresentação Conjunta na lista (clique no botão de rádio à 
esquerda), poderá, na qualidade Registante Principal ou de Membro, optar por uma das quatro 
ações seguintes: <Modify> [Modificar], <Delete> [Eliminar], <Leave> [Abandonar] ou 
<Cancel> [Cancelar].  

<Modify> [Modificar] permite-lhe modificar as informações do contacto e selecionar o 
contacto que irá utilizar nesta Apresentação Conjunta.  

<Delete> [Eliminar] resulta na eliminação da Apresentação Conjunta. Esta ação apenas é 
permitida se o utilizador for o Registante Principal e todos os outros Membros tiverem 
abandonado a Apresentação Conjunta. Se ainda existir um Membro ativo, o REACH-IT avisá-
lo-á de que esta Apresentação Conjunta tem participações confirmadas e não pode ser 
eliminada.  

<Leave> [Abandonar] é utilizado se, na qualidade de Membro, pretender abandonar a 
Apresentação Conjunta. Tenha em atenção que o Registante Principal não pode utilizar este 
botão até que outro Membro assuma a função de Registante Principal. 

<Cancel> [Cancelar] fá-lo regressar à página inicial do REACH-IT.  

 O Registante Principal e os Membros recebem mensagens internas adequadas 
quando os Membros abandonam a Apresentação Conjunta ou quando o Registante 
Principal nomeia outro Registante Principal. 

Por fim, clique numa das ligações da Apresentação Conjunta nas colunas <Name> [Nome] ou 
<Substance Id> [Id da Substância] se pretender ver os detalhes da Apresentação Conjunta 
correspondente. A página de detalhes mostra níveis diferentes de informações para o Membro 
(Figura 24) e para o Registante Principal (A opção <Assign New Lead> [Nomear novo 
Registante Principal] é utilizada para transferir a nomeação de Registante Principal para um 
Membro da Apresentação Conjunta (estão disponíveis informações adicionais no capítulo 
3.3.1), enquanto a opção <Manage Token> [Gerir Código] é utilizada para repor o contador 
para o Membro que excedeu o número máximo de tentativas.  
Figura 26) mas ambos abrangem as opções <Substance identification> [Identificação da 
substância], <Joint submission> [Apresentação Conjunta], <Contact> [Contacto] e <Third 
Party Representative> [Terceiro como Representante]. Além disso, o Registante Principal pode 
visualizar os detalhes dos Membros em <Joint submission members> [Membros da 
Apresentação Conjunta]. Esta funcionalidade não está disponível para os Membros. 
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Figura 24: Página Detalhes da Apresentação Conjunta do Membro 
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 Tenha em atenção que o estado do dossiê do Registante Principal pode ser 
representado por uma cruz vermelha ou por uma marca de escala verde. A cruz 
vermelha indica que o dossiê do Registante Principal não foi apresentado e aceite 
para processamento (Figura 24). Os Membros apenas poderão apresentar o seu 
dossiê quando a cruz for substituída por uma marca de escala verde. 

 Estão disponíveis botões adicionais (funcionalidades) na página de detalhes apenas 
para o Registante Principal, por exemplo, <Assign New Lead> [Nomear Novo 
Registante Principal] e <Manage Token> [Gerir Código] (Figura 26). Estes botões 
não estão disponíveis para os Membros da Apresentação Conjunta. 

 
A opção <Assign New Lead> [Nomear novo Registante Principal] é utilizada para transferir a 
nomeação de Registante Principal para um Membro da Apresentação Conjunta (estão 
disponíveis informações adicionais no capítulo 3.3.1), enquanto a opção <Manage Token> 
[Gerir Código] é utilizada para repor o contador para o Membro que excedeu o número 
máximo de tentativas.  
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Figura 25: Página Apresentação Conjunta pelo registante principal – Botões 
específicos (funcionalidades) 

 

3.3.1 Funcionalidade Nomear Novo Registante Principal 

 O Registante Principal atual pode transferir a sua função na Apresentação 
Conjunta (Figura 26) e atribuí-la a qualquer um dos outros Membros da 
Apresentação Conjunta. 

Para efetuar a transferência deve, na qualidade de Registante Principal atual, selecionar um 
dos Membros da Apresentação Conjunta (através dos botões de rádio à esquerda) e clicar em 
<Assign New Lead> [Nomear Novo Registante Principal], (Figura 26). 
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Figura 26: Página Nomear um Membro como Registante Principal 

 

Antes de atribuir a função de Registante Principal a um Membro da Apresentação Conjunta, o 
REACH-IT solicita ao utilizador que confirme a alteração (Figura 27). Se, na qualidade de 
Registante Principal atual, concordar com a reatribuição da função a um novo Registante 
Principal, deve clicar em <OK> (Figura 27). Em seguida, o nomeado deve aceitar a função de 
Registante Principal da Apresentação Conjunta. Se clicar no botão <Cancel> [Cancelar], o 
processo será cancelado e será direcionado para a página de detalhes. 

Figura 27: Página Confirmar Nomeação de (novo) Registante Principal 

 

Depois de o Registante Principal inicial ativar a alteração, o novo Registante Principal potencial 
verá um novo botão <Confirm Lead> [Confirmar Registante Principal] na respetiva 
Apresentação Conjunta, (Figura 28) a solicitar que confirme a aceitação da função de 
Registante Principal na Apresentação Conjunta. 

 A nomeação do novo Registante Principal ainda pode ser alterada enquanto a 
empresa selecionada não tiver confirmado a nomeação. 
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Figura 28: Botão de confirmação para o novo Registante Principal 

 

Depois de o Registante Principal inicial ter atribuído a função a outro Membro (nomeado) da 
Apresentação Conjunta, o botão <Confirm lead> [Confirmar registante principal] fica 
disponível para este Membro. 

Clique em <Confirm Lead> [Confirmar Registante Principal] se, na qualidade de novo 
Registante Principal nomeado, aceitar a função (Figura 28). Consequentemente, torna-se o 
Registante Principal ativo e é apresentada uma mensagem de confirmação (Figura 29). Clique 
em <OK> para a confirmação final ou em <Cancel> [Cancelar] para terminar a aceitação de 
novo Registante Principal. 

Figura 29: Página Aceitar Registante Principal 

 

 O novo Registante Principal nomeado não assume legalmente a função até: 

1. Confirmar a sua função como Registante Principal da apresentação conjunta no 
REACH-IT, e 

2. Apresentar com êxito um registo de Registante Principal. 

No entanto, até que as condições acima sejam cumpridas, o Registante Principal 
inicial continuará a ser considerado, em termos jurídicos, o Registante Principal da 
Apresentação Conjunta e continuará a ser responsável pelo conteúdo do registo de 
Registante Principal que apresentou inicialmente. 

 

Tenha em atenção que o novo dossiê de Registante Principal terá de ser 
apresentado como uma atualização espontânea do dossiê de Membro apresentado 
anteriormente. 

3.3.2 Funcionalidade Gerir código  
Na qualidade de Registante Principal de uma Apresentação Conjunta, o REACH-IT permite-lhe 
gerir o código e saber, por exemplo, qual a empresa que não introduziu corretamente o código 
mais vezes do que o número máximo de tentativas permitido. Além disso, o REACH-IT 
permite-lhe verificar qual a empresa que não introduziu corretamente o código de segurança 
para a Apresentação Conjunta mas não atingiu o número máximo de tentativas permitido. 

A funcionalidade <Manage token> [Gerir código] (Figura 26), disponível para o Registante 
Principal na página de detalhes <View joint submissions> [Ver apresentações conjuntas], 
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permite repor os contadores do código ou criar um novo código. Se clicar no botão <Manage 
token> [Gerir código], será direcionado para a página <Manage counter> [Gerir contador], 
onde poderá executar estas funções (Figura 30). 

Figura 30: Página Gerir Contador 

 

 Se o Membro utilizar o nome correto da Apresentação Conjunta, mas utilizar o 
código incorreto e exceder o número máximo de tentativas permitido, ser-lhe-á 
solicitado que contacte o Registante Principal para repor o seu contador. 

 Se o Membro tiver utilizado o nome incorreto da Apresentação Conjunta e o código 
correto ou incorreto, excedendo assim o número máximo de tentativas, o 
REACH-IT solicitará ao Membro que contacte a ECHA para repor o seu contador. 

3.3.3 Modificar as informações de contacto na Apresentação Conjunta  
Na parte inferior da página <View joint submissions> [Ver apresentações conjuntas], clique 
em <Modify> [Modificar] para alterar os detalhes da Apresentação Conjunta e os contactos da 
sua empresa. Como passo preliminar, deve, primeiro, selecionar o contacto que pretende 
modificar na lista de contactos (através dos botões de rádio à esquerda) (Figura 31). Em 
seguida, clique em <Modify> [Modificar]. 

Figura 31: Página Contactos da Apresentação Conjunta 
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É apresentada uma página de modificação (Figura 32). Se necessário, altere, pelo menos, 
todos os campos obrigatórios. Se pretender indicar outro contacto a utilizar para esta 
Apresentação Conjunta, deverá clicar em <Use in joint submission> [Utilizar na apresentação 
conjunta] e preencher todos os campos obrigatórios (Figura 32). 

Figura 32: Página Atualizar Contacto (pessoa) 

 

3.3.4 Eliminar uma Apresentação Conjunta  
Na página principal <View joint submissions> [Ver apresentações conjuntas] (Figura 26), 
clique em <Delete> [Eliminar] para eliminar totalmente a Apresentação Conjunta do sistema 
REACH-IT. O REACH-IT solicitar-lhe-á que confirme a eliminação da Apresentação Conjunta 
atual (Figura 33). 

Figura 33: Página Confirmar Eliminação  

 

 O Registante Principal não pode eliminar uma Apresentação Conjunta enquanto 
existirem Membros ativos. 
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Uma Apresentação Conjunta apenas pode ser eliminada pelo Registante Principal e apenas se 
todos os Membros da Apresentação Conjunta já a tiverem abandonado (utilizando o botão 
<Leave> [Abandonar] na respetiva Apresentação Conjunta). 

3.3.5 Abandonar uma Apresentação Conjunta como Membro  
Na qualidade de Membro, clique em <Leave> [Abandonar] na página <View joint 
submissions> [Ver apresentações conjuntas] se pretender abandonar a Apresentação 
Conjunta. O REACH-IT solicitar-lhe-á que confirme o abandono da Apresentação Conjunta 
atual (Figura 34). Pode abandonar uma Apresentação Conjunta em qualquer altura.  

Figura 34: Mensagem de confirmação para abandonar uma Apresentação Conjunta 

 

3.3.6 Abandonar uma Apresentação Conjunta como Registante Principal 
O Registante Principal NÃO está autorizado a abandonar a Apresentação Conjunta, a menos 
que tenha atribuído a função a outro Membro e este aceite a nomeação (ver detalhes no 
capítulo 3.3.1).  

3.3.7 Aceitar a função de Registante Principal numa Apresentação Conjunta  
O botão <Take lead> [Assumir função de registante principal] permite que o Membro nomeado 
assuma a função de Registante Principal de uma apresentação (ver detalhes no capítulo 
3.3.1).  

A discussão sobre qual dos Membros assume a função de Registante Principal deve ter lugar 
entre os Membros (fora do REACH-IT).  

Depois de o Membro nomeado aceitar a função através da opção <Confirm Lead> [Confirmar 
Registante Principal], o REACH-IT pedir-lhe-á para confirmar antes de se tornar o Registante 
Principal. 

 

4. Atualizar registos individuais para a Apresentação 
Conjunta 

Caso uma empresa tenha registado uma substância individualmente, ou seja, fora da 
Apresentação Conjunta, terá de efetuar os passos seguintes a fim de participar na 
Apresentação Conjunta relativa a essa substância: 
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1. Entre em contacto com o Registante Principal. Assegure-se de que a substância é 
efetivamente a mesma, entre no FIIS e inicie negociações para um acordo em 
matéria de partilha de dados. 

2. No REACH-IT, confirme a sua participação na Apresentação Conjunta, conforme 
descrito no capítulo 3.2 do presente manual. O Registante Principal terá de lhe 
fornecer o nome da Apresentação Conjunta e o código de segurança. 

3. Apresente novamente o seu dossiê de registo como uma atualização. Para 
participar efetivamente na Apresentação Conjunta, terá de apresentar novamente 
o seu dossiê como uma atualização espontânea do dossiê individual apresentado 
anteriormente. Quando criar o dossiê na IUCLID, devido a limitações técnicas, terá 
de selecionar «Change of tonnage band» [Alterar gama de tonelagem] como 
motivo para a atualização. Caso a sua atual gama de tonelagem seja a mesma que 
na sua apresentação anterior, tal não implicará uma fatura. 

Se participar na Apresentação Conjunta como Membro, quando criar o seu dossiê 
na IUCLID, selecione o modelo de Membro pertinente. Caso se torne no Registante 
Principal da Apresentação Conjunta, terá de selecionar o modelo pertinente que 
abrange os requisitos máximos na Apresentação Conjunta. 

Poderá obter informações pormenorizadas sobre como criar o dossiê IUCLID no 
Manual de Apresentação de Dados 4 – «Como obter aprovação nas regras de 
negócio». 

4. Apresente o seu dossiê através do REACH-IT. Quando o apresentar, não se 
esqueça de assinalar a caixa «Related to Joint Submission» [Relacionado com a 
Apresentação Conjunta] e de introduzir o nome da Apresentação Conjunta. 
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